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NAVIGATION INSTRUCTIONS
The symbols in the left-hand margin of each page of the manual will enable you to carry out the following functions:

 i The buttons in text below do not function. They are for illustrative purposes only.

Click on this button to display the Contents page.

Back one page.

Forward one page.

Back button.

Forward button.

Click this button to print some or all of the document (specific pages can be chosen).

Click this button to exit the user guide.

 ! Press the Esc key to display normal Acrobat© Controls.

Contents

Exit
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1. Introduction
1.1 General
ViCapture™ adds image capture and mark up capabilities to Vision Engineering’s Lynx EVO and Mantis ranges of inspection 
solutions.

1.2 Main features
Image capture 
ViCapture™ can capture an image or up to 30 seconds of video. Still images can be saved as .PNG, .JPG and .BMP files whilst 
video can be stored in .AVI format. The design allows maximum emphasis on the live and captured image, making annotation 
easier and clearer.

Saved images can be reloaded for subsequent inspection and/or mark up.

Annotating captured images 
Images can be marked up with shapes, lines, text and arrows in various colours with text in any of the fonts available on the PC.

Overlays 
Images can also be enhanced with a coloured crosshair and imported overlays.

 i Imported overlays must be the same pixel dimensions as the image, saved as .PNG files with a transparent background.

Image control 
ViCapture™ software allows the user to manually or automatically control exposure and white balance. In addition, the Focus Aid 
feature provides a relative scale of sharpness so the user can establish the best possible focus.

Advanced features 
These features (only accessible in Supervisor mode - see page 13) include mirroring the image, adding a time stamp, colour filter 
control and adjusting the pixel clock rate.
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2. Initial set-up
2.1 System requirements
The following are the minimum system requirements that will enable ViCapture™ to operate up to 18.3 frames per second 
refresh rate:

• Operating system Microsoft® Windows® 7 (32 & 64-bit) and Microsoft® Windows® 10 (64-bit)

• CPU type  Intel® Core™ i5, with CPU clock of 2.5 GHz 

• Chipset  Intel H81 chipset, or equivalent 

• Display card  Dedicated video graphics card, capable of 1600x1200 with live video streaming,  
    or Intel HD4000 “on-board” video graphics card 

• Display resolution 1600x1200 

• Memory  4GB 

• Disk space  200GB solid state hard drive - for installation, plus data and image storage 

• USB  USB2.0 ports

• Adobe® Flash® Adobe® Flash® Player v15 

• Other  Windows-compatible mouse and keyboard

The following system requirement differences will allow the system to operate correctly but at a reduced frames per second 
refresh rate: 

• Operating system Microsoft® Windows® 7, and 10 (32 & 64-bit)

• CPU type  PC with Intel i3 or better

• Memory  min. 2 GB

• Disk space  min. 500 MB

• USB  Free USB 2.0 port (High Speed 480 Mbit/s)
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2.2 Installing the software

 X Insert the ViCapture™ USB stick supplied into your PC.

 X Navigate to the USB’s content and double click on the Setup.exe file.

 X The ViCapture™ run screen will be displayed (Figure 1):

Figure 1: ViCapture™ run screen

 X Click Run.

 i If a system instruction requests installation of .NET Framework, cancel ViCapture installation, install the .NET 
Framework supplied on the USB stick with the software, then re-initiate the installation.
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 X The ViCapture™ installation wizard dialog box will be displayed.

Figure 2: ViCapture™ installation wizard

 X Click the Next> button and follow the instructions on subsequent screens until the Installation Complete screen is displayed.

Figure 3: ViCapture™ installation wizard

 X Click Close.

 X The USB stick can now be removed.
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2.3 Starting the software

 X Double click the ViCapture™ logo  on the PC’s desktop screen or a single click from the icon in the start menu.

Figure 4: ViCapture™ start-up screen

 X After the start-up screen has been displayed, the initial screen will be displayed.

Figure 5: ViCapture™ initial screen

 X Select the required language from the drop down list if necessary.
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2.4 Connecting the camera

 X Connect the camera output from the Vision device to a USB port on the PC.

 i Please wait while drivers are loaded at the first installation of a new device.

 X Click on the Settings tab and then click on Scan.

 X Select the required camera from the drop down list if necessary, and its image will be displayed.

Figure 6: ViCapture™ device scan screen
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3. Image capture

 i If the quality of the image displayed requires improvement, refer to Section 4 Image adjustment.

3.1 Still image capture and storage

 X When the play/pause button has a blue background (  ) the image displayed is live.

 X Arrange the object such that the image displayed is the image to be captured and click the play/pause button. The 
background will turn grey (  ) and the captured image will be displayed.

 i If you wish to mark up the image or import an overlay before it is saved, see page 19 or page 21 respectively.

 X To save the captured image, click . The Save as window will be displayed.

 i To set the type of file that will be saved (.PNG, .JPG or .BMP), see page 27.

 X Navigate to the required folder if necessary, change the suggested file name as appropriate and click the Save button.

 i To retrieve a saved still image, see page 27.

3.2 Video capture and storage

 X When the play/pause button has a blue background (  ) the image displayed is live.

 X Click the video capture icon . The Save as window will be displayed.

 X Navigate to the required folder if necessary, change the suggested file name as appropriate and click the Save button. A 
video recording of the display area will start.

 X Click on  to stop the recording or wait for the recording to stop automatically (after 30 seconds). The video will be 
saved in .AVI format.
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4. Image adjustment

 i There are two levels of image adjustment: user level and supervisor level. The supervisor level is password protected.

4.1 Supervisor mode
The supervisor mode enables users to access extra image adjustments and other advanced features of the software.

4.1.1 Entering/exiting supervisor mode

 X To enter the supervisor mode, click the  button and enter the password (default password: Vision) and click OK.

 X The supervisor icon  will be displayed.

 X To exit the supervisor mode, click the unlocked supervisor button .

4.1.2 Setting a new password

 X To set a new password, enter the supervisor mode and click on the Settings tab.

 X Click Set Password.... The screen below will be displayed.

Figure 7: Change Supervisor Password screen

 X Enter the current password, the new password and confirm the new password then click OK.

 i The new password must be at least 8 characters, contain at least one capital letter, one lower case letter and one 
number.
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4.2 Auto exposure
4.2.1 Standard user access

 X Click the Image tab. The Auto Exposure tab will be highlighted.

 X With Auto Exposure set to Off, the Gain and Exposure settings can be manually adjusted by dragging the appropriate 
marker along the value bar. The Brightness Ref feature is not accessible.

 i Before turning the Auto Exposure On, set the Exposure level to the required value.

 X By clicking the On radio button, the Brightness Ref setting becomes adjustable whilst Gain and Exposure are not.

 X Adjust the Brightness Ref value as required and the Gain and Exposure will automatically adjust. Priority is set so that 
Gain will adjust in preference to Exposure until the gain limit is reached.

4.2.2 Supervisor access

 X In the Supervisor mode (see page 13), in addition to the settings available in the standard user mode, the Black Level 
and Gamma settings are displayed.

 X The values for these settings can be manually adjusted with Auto Exposure on or off.

4.3 Auto white balance 
4.3.1 Standard user access

 X Click the Image tab and then the Auto White Balance tab.

 X Click the On or Off radio button as required.

 i When Auto White Balance is set to off, the current white balance settings are kept.
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4.3.2 Supervisor access
 X In the Supervisor mode (see page 13) there is a Temperature feature. This allows the colour temperature of the 
illumination to be set.

 X When auto white balance is off, click the box to the left of the Temperature slider so a tick appears.

 X Drag the Temperature slider to the required value.

 i Auto white balance adjusts the white balance slowly. It is especially important to note this when adjusting the 
colour temperature to ensure the white balance setting has stabilised.

4.4 Focus aid
The Focus Aid feature provides a relative scale of sharpness so the user can establish the best possible focus as follows:

 X Click the Focus Aid tab. An adjustable rectangle will appear in the top left corner of the image.

 X Move the rectangle over the area of interest and adjust its size if required.

 X Adjust the focus of the Vision instrument in use. The current focus value is shown above the scale (located to the right of 
the image - see below) whilst the maximum focus value is displayed to the right of the scale.

Figure 8: Focus Aid screen
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4.5 Sizing the display area
The display area has the following sizing controls:

•  Displays image pixel 1:1 with screen pixels

•  Displays the image 1:2 so one screen pixel represents two camera pixels

•  Scales the image to fit the full height of the display area

•  Displays the ViCapture window full screen (no status bar) and can be used in conjunction with any of the above

Examples of these sizes can be seen below:

Figure 9: Display sizing examples

 X Click the appropriate button to change the display area accordingly.

 i To allow on screen zooming, the image can be moved within the display frame. If the image is moved outside the 
visible area, click to resize the image which will also bring the image back into the visible frame.
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5. Advanced features
5.1 Advanced image control

 i These features can only be accessed in the Supervisor mode (see page 13).

The advanced image control settings are as follows:

• Mirror (image flipping)

• Timestamp

• Colour filter

• Pixel clock adjust

5.1.1 Mirror

This facility enables the live image to be flipped left to right or top to bottom.

 X Click on Left/Right or Up/Down as required.

5.1.2 Timestamp

This feature will show the date and time on a live image and the captured time will be displayed on the saved image.

 X Before selecting this function, click the Mark Up tab and select the required font, point size and colour for the timestamp.

 X Return to the Advanced tab and turn the Timestamp to on.

 i The timestamp will remain on even when the supervisor mode is switched off.

5.1.3 Colour filter

 X Select the colour filter appropriate for your product from the drop down list.
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5.1.4 Pixel clock adjustment

The pixel clock value sets the speed at which the pixel data is read from the individual pixels (within the capabilities of the 
computer) and so affects the possible exposure time. So for customers who want to see the smoothest movement they should 
tend towards fast pixel clock to allow short exposure times. Customers who don’t need the smoothness of movement can get 
enhanced image quality by turning the pixel clock to a lower setting.

5.1.4.1 Manual Pixel Clock adjustment

 X With Automatic Pixel Clock adjustment set to Off, move the slider to the left to decrease the clock speed or to the right 
to increase it.

5.1.4.2 Automatic Pixel Clock adjustment

 X Click the On radio button to turn the automatic setting on. The pixel clock will now automatically set itself to the correct 
value.

5.1.5 Saturation

 X Use the slider control to set the Saturation level to the required value.
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5.2 Mark up
The mark up feature enables rectangles, ellipses, lines, arrows and text to be added to the display area.

5.2.1 Shapes, lines and arrows

 X Before adding a mark up, select the colour and line thickness of any shape, line, or arrow that is to be added.

 X Click on the appropriate button and a circle, square, line or arrow (single or double ended) will be displayed in the top left 
corner of the image.

 X Drag the mark up to the area of interest and use the adjustment squares around the perimeter of the mark up to change 
its size and shape.

 X With the mark up selected clicking the right mouse button will display a menu with the following options:

• Select all (markups and any overlays)

• Unselect all (markups and any overlays)

• Delete (the selected mark up)

• Delete all (mark ups and any overlays but not the time stamp or crosshair)

• Move to front (moves the selected mark up to be displayed at the front of any others)

• Move to back (moves the selected mark up to be displayed at the back of any others)

• Undo (cancels the previous menu action)

• Redo (reverses the previous Undo action)

• Reset properties (reverts a mark up shape to a black outline and minimum thickness)
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5.2.2 Text mark up

This feature enables text annotations to be added to the display area.

 X Before adding text, select the colour font type and point size of the text to be added.

 X Click on the text (T) button and a text box will be displayed.

 X Double click inside the box and enter the required text. 

 X Drag the text box to the area of interest and use the adjustment squares around the perimeter of the box to change its size.

 i The text can be edited after moving the text box into position.

 X With the text box selected (but not in text entry mode, clicking the right mouse button will display a menu with the 
following options:

• Select all (markups and any overlays)

• Unselect all (markups and any overlays)

• Delete (the selected mark up)

• Delete all (mark ups and any overlays)

• Move to front (moves the selected mark up to be displayed at the front of any others)

• Move to back (moves the selected mark up to be displayed at the back of any others)

• Undo (cancels the previous menu action)

• Redo (reverses the previous Undo action)

• Set properties (reverts the text to 4 point Arial black)
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5.3 Overlay

 X Click the Overlay tab to overlay the display area with either or both of the following:

• Display a coloured crosshair (in supervisor mode only - see page 13)

• Overlay files (see page 22)

5.3.1 Crosshair

 X With the supervisor mode on (see page 13), select the required colour from the drop down list.

 X Click the On radio button. A crosshair will be placed in the centre of the display area (see below).

Figure 10: Crosshair example

 i Once set to On, the crosshair will remain displayed even when not in the supervisor mode. To turn the crosshair 
off, the supervisor mode must be on.

No Crosshair With Crosshair
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5.3.2 Overlay files

Overlay files can be used to highlight specific areas of the displayed image. 

 i Overlay files must be .PNG files with a transparent background. The dimensions of the overlay file must match 
the camera being used.

5.3.2.1 Managing overlay files

 i To manage overlay files, the supervisor mode must be on (see page 13).

 X With the Overlay tab selected, click on the Browse icon  to the right of the Source drop down list. The Overlay 
Manager window will be displayed.

Figure 11: Overlay Manager window

 X To import an overlay file, click the Add... button. 

 X Navigate to the folder containing the required file and import it. The file name will be added to the list.

 X To remove an overlay file from the list, click on the file name in the list and then click Remove.

 X When overlay management is complete, click Close.
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5.3.2.2 Displaying overlay files

 X With the Overlay tab selected, click on the Source drop down list and select the required file.

 X The overlay file will be displayed in the image area (see below).

Figure 12: Overlay file example

 X To remove an overlay file from the display, click on the Source drop down list and select None.

No Overlay With Overlay
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6. Settings
The Settings tab enables a user to carry out the following:

• Camera selection

• Load a settings file

• Save the current settings (Supervisor mode only - see page 13)

• Manage the settings files (Supervisor mode only - see page 13)

• Language selection

• Change the Supervisor password (Supervisor mode only - see page 13)

6.1 Camera selection

 X Click the Scan button to populate the camera drop down list with any cameras connected to the PC via a USB port.

 X Select the required camera from the drop down list if necessary.

6.2 Load a settings file

 X Select a settings file from the drop down list and then click the Load button.
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6.3 Save the current settings

 i To save the current settings the software must be in the Supervisor mode (see page 13)

 X To alter the settings values for an existing settings file, select the required settings file from the drop down list and click the 
Save button. The following indicates which current setting values will be saved per tab:

• Image 
Auto exposure (On/off) 
Brightness reference 
Gain 
Exposure 
Gamma 
Black level 
Auto white balance (on/off and colour temperature)

• Focus-aid 
Focus assist box (location)

• Settings 
Settings files (file details saved for recall but not saved with settings) 
Language 
Password (password saved if changed but not changed with settings)

• Overlay 
Crosshair (On/Off and colour) 
Overlay (file details saved for recall but not saved with settings)

• Mark up 
Annotation (Line colour and line thickness and location of active annotations) 
Text (font, size colour and location of active annotations)

• File 
File type (PNG or JPG or BMP)

• Advanced 
Mirror 
Time stamp (on/off, colour, font, size and location) 
Colour filter 
Auto pixel clock adjust (on / off) 
Auto pixel clock settings 
Saturation

 i Security status is not saved. This means if a user closes the software whilst it is in ‘Supervisor mode’ it will NOT 
be in ‘supervisor mode’ when it reopens
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6.4 Managing the settings files

 i To manage the settings files the software must be in the Supervisor mode (see page 13).

 X Click on the Manage button. The Camera Settings window will be displayed.

Figure 13: Camera settings window

6.4.1 Save As...

 X Click Save As.... The Save as window will be displayed.

 X Change the suggested file name as appropriate and click the Save button.

6.4.2 Save

 X Click on a settings file from the list displayed and then click Save. 

6.4.3 Import

 X Click on the Import button. The Open window will be displayed.

 X Navigate to the required folder if necessary, select the required settings file and click the Open button.

6.4.4 Remove

 X Click on a settings file from the list displayed and then click Remove. The file will be removed from the list.
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7. File
The File tab enables a user to carry out the following:

• Load a Still image

• Change the file type that can be loaded (Supervisor mode only - see page 13)

7.1 Load a still image

 X Click on the Load button. The Open window will be displayed.

 X Navigate to the required folder if necessary, select the required image file and click the Open button.

7.2 File type selection

 i To select the type of file to be loaded the software must be in the Supervisor mode (see page 13).

 X Select the required file type from the drop down menu. The file types available are as follows:

• .png

• .bmp

• .jpg
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Contacts

Distributor

For more information...

Vision Engineering has a network of offices and technical distributors around
the world. For more information, please contact your Vision Engineering
branch, local authorised distributor, or visit our website.

Disclaimer – Vision Engineering Ltd. has a policy of continuous development and reserves the right to change or
update, without notice, the design, materials or specification of any products, the information contained within
this brochure/datasheet and to discontinue production or distribution of any of the products described.

Vision Engineering Ltd.
(Central Europe)
Anton-Pendele-Str. 3,
82275 Emmering, Deutschland
Tel: +49 (0) 8141 40167-0
Email: info@visioneng.de

Vision Engineering Ltd.
(France)
ZAC de la Tremblaie, Av. de la Tremblaie
91220 Le Plessis Paté, France
Tel: +33 (0) 160 76 60 00
Email: info@visioneng.fr

Vision Engineering Ltd.
(Italia)
Via G. Paisiello 106
20092 Cinisello Balsamo MI, Italia
Tel:  +39 02 6129 3518
Email: info@visioneng.it
 
Nippon Vision Engineering
(Japan)
272-2 Saedo-cho, Tsuduki-ku,
Yokohama-shi, 224-0054, Japan
Tel: +81 (0) 45 935 1117
Email: info@visioneng.jp

Vision Engineering
(China)  
11J, International Ocean Building,
720 Pudong Avenue, Shanghai,
200120, P.R. China
Tel: +86 (0) 21 5036 7556
Email: info@visioneng.com.cn

Vision Engineering
(South East Asia)
P-03A-20, Impian Meridian,
Jalan Subang 1,
USJ 1, 47600 Subang Jaya,
Selangor Darul Ehsan,
Malaysia
Tel: +604-619 2622
Email: info@visioneng.asia

Vision Engineering
(India)
Email: info@visioneng.co.in

Vision Engineering Ltd.
(Manufacturing)
Send Road, Send,
Woking, Surrey, GU23 7ER, England
Tel: +44 (0) 1483 248300
Email: generalinfo@visioneng.com

Vision Engineering Ltd.
(Commercial)
Monument House, Monument Way West,
Woking, Surrey, GU21 5EN, England
Tel: +44 (0) 1483 248300
Email: generalinfo@visioneng.com

Vision Engineering Inc.
(Manufacturing & Commercial)
570 Danbury Road,  
New Milford, CT 06776  USA
Tel: +1 (860) 355 3776
Email: info@visioneng.com

Vision Engineering
(Brasil)
Email: info@visioneng.com.br        
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